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Introduction 
The Impervious Surface Analysis Tool (ISAT), which is available as a geographic information 
system script, is used to calculate the percentage of impervious surface area within user-
selected geographic areas (e.g, watersheds, municipalities, subdivisions). In small watersheds, 
the correlation between an increase in impervious surfaces and a decrease in water quality 
has been well established. Users can use the information derived from ISAT to predict how 
different management scenarios might impact local water quality. 
 
The National Oceanic and Atmospheric Administration (NOAA) Coastal Services Center has 
developed ISAT to help managers and planners make a determination about the impact of 
impervious surface coverage on local water quality. ISAT applies impervious surface coefficients 
to remotely sensed land cover data to determine the total and the percentage of impervious 
surface area within specified polygons. ISAT can also be used to demonstrate the effects of land 
cover change on a watershed’s imperviousness. The coefficients in ISAT were developed to be 
used with the NOAA Coastal Services Center’s Coastal Change Analysis Program (C-CAP) land 
cover data, but can be modified for use with various types of land cover data or to match the 
land cover/land use practices within a specific geographic region.  
 
Although this tutorial describes the basic operations of the ISAT tool, it does assume the user 
has an intermediate level of familiarity with standard ArcView functionality and a basic 
understanding of land cover data. For more detailed information on C-CAP land cover data, 
please refer to the C-CAP Web site at www.csc.noaa.gov/digitalcoast/data/ccapregional. 
 

Setup Instructions for Installing ISAT 
When you downloaded ISAT, you received a zip file containing ISAT Toolkit.tbx (an ArcGIS 
custom toolbox) and the sample data files required to walk through this tutorial. Create a 
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C:/ISAT_Tutorial directory and extract the zipped ISAT files into this folder.  
 

1. To add the ISAT tool to ArcMap, double-click the ISAT_Tutorial.mxd map project 
located in the Tutorial folder at C:/ISAT_Tutorial.  

2. Open the ArcToolbox sidebar and dock it so that it displays in the ArcMap user 
interface.  

3. In the ArcToolbox sidebar right-click on the ArcToolbox folder at the top and select 
Add Toolbox. Navigate to the C:/ISAT_Tutorial folder and select ISAT Toolkit.tbx. 
The ISAT tool will now be added as a custom Toolbox.  

4. Expand the ISAT Toolbox in ArcToolbox to view the scripts.  
 

Note: The Spatial Analyst Extension must be turned on for the ISAT tool to work. This tutorial 
was also written using ArcGIS version 10.1. If using ArcGIS version 10.0, you will need to make a 
new map project (mxd) other than the one provided and add the required layers as noted in the 
steps below. 
 

Required Layers 
Specific data is required to run the ISAT Tool in ArcGIS. The sample data provided in this tutorial 
describes the necessary data in detail and should be used as a guide when obtaining data for 
use in other areas. The processes in this Tutorial can be recreated for any area depending on 
data availability.  
 

1. Analysis Theme - shapefile that contains polygons of the areas you want to analyze. 
2. Land Cover Grid - land cover data.  
3. Impervious Surface Coefficients – percentage of impervious area per land cover 

class based on National Land Cover Database (NLCD) imperviousness values. (Note: 
These coefficients will be derived as an example in the Tutorial and the process can 
be repeated for other areas.) 

4. Population Data (required only for imperviousness coefficient derivation process) 
 

Obtaining the Data 
The Tutorial data provided is sufficient for learning the ISAT tool but the below data resources 
can be used to obtain datasets for performing ISAT analyses for your own study area. The 
resources below cover two of the required data components for running the ISAT tool. The 
Analysis Theme polygons data is entirely up to the user and can be provided by a host of data 
sources. 
 
 
C-CAP Land Cover Change Data 
The land cover data used in this Tutorial was downloaded from the NOAA Coastal Services 
Center Digital Coast website (www.csc.noaa.gov/digitalcoast). C-CAP data is available for the 
coastal intertidal areas, wetlands, and adjacent uplands of the contiguous U.S., Puerto Rico, the 
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U.S. Virgin Islands, Hawaii, and the Pacific Islands territories. There are many dates available to 
be used for comparison of land use change over time as well as multiple resolution options. The 
Tutorial data set is located in New Jersey, has a horizontal resolution of 30 meters, with a 
spatial reference of the North American Datum of 1983 (NAD 83). To download C-CAP data for 
your area please refer to the options available at the web page 
www.csc.noaa.gov/digitalcoast/data/ccapregional/download.  
 
NLCD2006 Percent Developed Imperviousness 
The land cover imperviousness coefficients used in this Tutorial are derived from a dataset 
contained in the Multi-Resolution Land Characteristics Consortium’s (MLRC) National Land 
Cover Database for 2006 (NLCD2006). The database includes the NLCD2006 Percent 
Development Imperviousness raster layer which is used in conjunction with the C-CAP land 
cover data to derive imperviousness coefficients for high, medium, and low population 
scenarios. This layer is a nationally available data set that is updated on a five year cycle. The 
product has a 30 meter horizontal resolution and has an Albers Conical Equal Area projection. 
Once obtained, the layer should be projected to the same coordinate system as the land cover 
data. To download the national dataset navigate to www.mrlc.gov/nlcd06_data.php and 
download the NLCD2006 Percent Developed Imperviousness data from the Product Data 
Downloads section. The coefficient derivation process used in this Tutorial can be applied to 
other study areas. 
 

ISAT Tutorial  
 
Add Data 
The required datasets have been downloaded for use in this tutorial. All data and necessary 
files are located in the ISAT_Tutorial folder that was saved to your C: drive. The data layers have 
been clipped to the study area and have all been projected to match the land cover data 
projection using ArcToolbox functions. 
 

1. Open the ISAT_Tutorial.mxd map project if it is not already open.  
2. Expand and review the njccap06 layer in the Table of Contents. This is C-CAP land 

cover data for the New Jersey area collected in 2006 at a 30-meter resolution. There 
are 21 land cover types in this data set. 

3. Click the Add Data button and add the imprvs06 data set from the ISAT_Tutorial.gdb 
geodatabase to the map. This is the NLCD imperviousness layer for 2006, also 
collected at a 30-meter resolution. 

4. Change the symbology for the imprvs2006 layer from black and white to an inverted 
Spectrum-Full Bright (red-to-blue) color scheme. See image below. Note the red 
areas are areas of high imperviousness near 100%.  
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5. Add the Analysis Theme polygon. Navigate to the ISAT_Tutorial geodatabase and 

add NJ_HUC14.shp to your map. This is the analysis layer that will be used to 
determine imperviousness for areas based on hydrologic unit codes, or HUCs.  

6. Turn all layers off except for imprvs06 in preparation for the next steps.  
7. Save your map. 

 
Create the Imperviousness Coefficients 
The NLCD2006 Imperviousness raster layer will be used in this step to create the 
imperviousness coefficients necessary to run ISAT. ArcMap and Microsoft Excel will be used to 
create the spreadsheet that is referenced by ISAT. The coefficients will be generated for each 
land cover type and high, med, and low population statistics. 
 
NOTE: If you already have imperviousness coefficients for your study area in an acceptable 
format proceed to the next section of the tutorial. The coefficient attributes MUST be formatted 
like the example below in order for ISAT to run. 
 

1. Open a new Microsoft Excel spreadsheet. Name the file LC_ISvalues and save the file 
type as a .csv in your ISAT_Tutorial folder.  

2. Format the coefficients spreadsheet for ISAT. In the first row type the following text 
into the A,B,C,D, and E columns. Value, LCName, High, Med, Low. In row two type 
in the following text into the A,B,C,D, and E columns. 0, Unclassified, 0, 0, 0. See 
image below for help. 
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3. Add land cover class names and values to the spreadsheet. Right-click on the 
njccap06 layer in the Table of Contents and select Open Attribute Table. Using the 
Table Options dropdown in the attribute table select Export. Save the Output Table 
as lc_names.dbf and save to your Tutorial folder, making sure to select dBASE Table 
for the Save as Type option. Do not add the table to the current map when 
prompted. 

4. Open the lc_names.dbf file using the Excel project you already have open. Be sure to 
select dBase Files (*.dbf) as the file type to open or you won’t see the table in your 
folder. 

5. Click on the View tab in Excel. Click the Arrange All button to view both excel 
projects side-by-side. Choose the Vertical option when prompted for display 
options. 

6. In the lc_names spreadsheet click and drag to select the land cover values from the 
VALUE column from cells B2 to B22. Right-click on the selected cells and select Copy. 
Paste the values into the LC_ISvalues spreadsheet at cell A3. (Note that it should 
begin with a value of 2 and end with 22). 

7. Scroll over to the CLASS_NAME row in lc_names and copy the land cover class 
names starting at G2 and ending at G22. Paste the data into LC_ISvalues in the B3 
cell so they are listed next to their corresponding class values. Your LC_ISvalues 
spreadsheet should now look identical to the image below. 
 

 
8. Save the LC_ISvalues spreadsheet but keep it open. Close the lc_names spreadsheet 

without saving. The LC_ISvalues spreadsheet is now formatted properly for ISAT and 
is ready for the coefficients to be added. 

9. Next, you will use ArcToolbox tools to create the coefficients using the tutorial data.  
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10. Maximize your map. Open the ArcToolbox sidebar if necessary and dock it in your 
map window.  

11. A population statistics layer is required for this analysis. Click Add Data and add the 
NJPopData polygon layer from your ISAT_Tutorial.gdb geodatabase. Right-click on 
the layer in the table of contents and select Open Attribute Table. Scroll through the 
attributes and scan the information. The data contains a variety of population 
information for municipalities and is generally publicly available for download for 
most geographic locations. 

12. Scroll over to the PopDensity attribute column. This is population density for 2010 
(population/sq. mile). You will use this to base your population parameters on for 
the imperviousness coefficients.  
 

NOTE: The values used in this tutorial are not to be considered as the standard for use. The 
values are completely up to the ISAT user and can vary for location and desired analyses results. 

 
13. Right-click on the PopDensity attribute column header and select Statistics. The 

Frequency Distribution table in the statistics is one example of where you would 
analyze the population distribution and decide on the Low, Medium, and High 
population parameters for the imperviousness coefficients. Ideally, you would locate 
breaks in the population ranges to determine the breakpoints. For this data set you 
will use the following pre-selected breakpoints. 
 
                  Low <=500       Medium >500 and <=2500          High > 2500      
 

NOTE: ISAT users should make an informed decision on what parameter(s) to use to change 
impervious coefficients (we recommend population density) and also to determine what their 
thresholds, or breaks, will be.  We recommend looking at a well-resolved histogram to do this, 
but it could be done in other ways not described in this tutorial. A good way to view the data is 
to use the Histogram tool in the Microsoft Excel Analysis ToolPak Add-In. A good resource for 
using this method can be found at the link: http://support.microsoft.com/kb/214269 

 
14. Close the statistics table. Remaining in the NJPopData attribute table click Table 

Options and select Select by Attributes. Create a new selection on the layer that 
reads “PopDensity” > 2500. This will select all of the HIGH population areas to be 
used for the imperviousness coefficients development. Click Apply. 

15. Close the Attribute Table and examine the data layer to see the selected polygons 
with a HIGH population designation. Toggle the NJPopData layer on and off with the 
imprvs06 layer to see how high population density corresponds with 
imperviousness. 

16. Right-click on the NJPopData layer in the Table of Contents and select Data > Export 
Data. Save the selected features to your ISAT_Tutorial.gdb geodatabase and name 
the layer NJPopHigh. Click OK. Add the layer to the map when prompted. Turn off 
the NJ_PopData layer. Clear all selected layers in the map. 
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17. In the ArcToolbox sidebar navigate to the Spatial Analyst Tools > Zonal toolbox and 
double-click the Zonal Statistics as Table tool. Populate the tool parameters with the 
inputs below. 
 

Input raster or feature zone data: njccap06 
Zone field: VALUE 
Input value raster: imprvs2006 
Output table: C:\ISAT_Tutorial.gdb\NJPopHigh 

 

Leave the other options at their defaults. Click on the Environments tab at the 
bottom of the tool interface. Expand the Processing Extent section. From the Extent 
dropdown choose the Same as layer NJPopHIGH option. Click OK. Click OK again to 
run the tool.  

18. An output table named NJPopHIGH will be added towards the bottom of your Table 
of Contents. Right-click the table and select Open. Identify the MEAN column. These 
values represent the imperviousness coefficients for the High population land cover 
types. The VALUE row represents the class name codes that will be used to link the 
coefficients to the land cover types found in the LCISvalues spreadsheet.  
 

NOTE: Count down through the VALUE attribute column from 2 to 22 noting any missing values. 
The land cover class names that correspond with the values should all be accounted for. Notice 
that as you count through the rows from 2 to 22 that the value 16 is missing. This is very 
important to note as it can cause improper coefficient values if not adjusted. Maximize the 
LC_ISvalues worksheet and see which land cover class name corresponds to the class name 
value of 16. The value of 16 should correspond to the Estuarine Forested Wetland land cover 
type. This means that during the analysis there was no Estuarine Forested Wetland found in the 
analysis theme area and was therefore omitted. In the next steps you will adjust the coefficients 
worksheet for this but it is very important to note and address any omitted land cover types for 
future analyses. If using your own data there may be other land class types omitted if they are 
not present within the analysis theme polygon area. 

 
19. Click the Table Options dropdown and select Export. Save the table as LC_High.dbf 

to the ISAT_Tutorial folder making sure to select the Save as Type as dBASE Table 
from the dropdown option. Click OK to export the table.  Do not add the table to 
your map when prompted. 

20. Maximize your LC_ISvalues.csv worksheet. Select File > Open, navigate to the 
ISAT_Tutorial folder and open the LC_High.dbf table. On the Main Menu in Excel 
select the View tab. Click the Arrange All function to view the two files side-by-side. 
Choose the Vertical option when prompted.  

21. Select and copy the cells in the MEAN column in LC_High.dbf starting at G2 and 
ending at G21.  

22. Paste the data into cell C3 of the LC_ISvalues worksheet. 
23. Fix the coefficient for the omitted land cover classes if necessary, from step 18. 

Right-click in the cell to the right of Estuarine Forested Wetland in the LC_ISvalues 
worksheet and select Insert > Shift Cells Down. Click OK to shift the cells down.  

Page 7 of 15 
 



ISAT for ArcGIS 10.x 
 

24. Type a 0 in the corresponding empty cell. The coefficients worksheet is now 
complete for the High Population analysis scenario.  

25. Format the cells. Click and drag over the C,D, and E column headers above the High, 
Med, and Low entries to select the entire contents of the columns. Right-click and 
select Format Cells. For the Category select Number and select the default at 2 
decimal places. Click OK.  

26. Make sure your worksheet looks identical to the image below up to this point. Note 
the red box illustrating the replaced Estuarine Forested Wetland value. Save your 
worksheet.  

 
27. Repeat the coefficient derivation process for the Medium and Low population 

breakpoints. Starting at step 14 in this section of the tutorial repeat the process first 
for the Medium category population parameters (Medium >500 and <=2500) and 
then finally for the Low population category (<=500).  
 

NOTE: Remember to check for any missing land cover classes by scanning the Value list in the 
Zonal Statistics by Output tables and comparing them with the LCName column in LC_ISvalues! 
There should be no numeric break between 2 and 22. 

 
28. Review your LC_ISvalues coefficients worksheet for use in ISAT. Your LC_ISvalues 

worksheet should look identical to the image below after calculating and adding in 
the Medium and Low population imperviousness coefficients. Make sure of this 
before moving on to the next steps. 
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Run a Basic Analysis using the ISAT Tool 
All of the necessary data is now available to run the ISAT tool. Some additional data sets 
provided for you will be used in this section for the reclassification scenarios. These data may or 
may not be required depending on your use of ISAT. 
 

1. Prepare your map display for ISAT analysis. In the Table of Contents make sure your 
view is the List by Drawing Order view. Remove the NJPopLow, NJPopMed, and 
NJPopHigh layers from your map. Remember, the NJ_HUC14 analysis theme layer 
has already been added to your map.  

2. Turn off all layers in your map project except for NJ_HUC14, njccap06, and the 
Basemap imagery.  

3. Run the ISAT tool. Double-click the ISAT with Change Scenarios script in the 
ArcToolbox sidebar.  

4. Populate the script interface with the following parameters.  
 

Input Raster: njccap06 
Statistical Zone Layer: NJ_HUC14 
Statistical Zone Field: HUC14 
Coefficient File: C:\ISAT_Tutorial\LC_ISvalues.csv 
Class of Coefficients to Use: High 
Output Layer: C:\ISAT_Tutorial.gdb\ISAT_High 
 

5. Click OK to run the ISAT tool. The ISAT_High layer will be added to your map and 
should look similar to the image below.  
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The default legend applied to the new theme indicates the potential impact to water quality 
based on the estimated percentage of imperviousness within each analysis field. Green areas 
correspond to <10% impervious surface (Protected), yellow areas correspond to 10%-25% 
impervious surface (Degraded), and red areas correspond to >25% impervious surface 
(Impacted).  
 
NOTE: The above symbology for the ISAT output layers will not be applied if you choose to 
remove the layer from the map and then add it back in later. One solution to this is to export the 
layer as a LYR file which will capture and maintain the symbology. Once you have a LYR file you 
can import the symbology in the layer properties and apply it to any previous ISAT runs. A 
sample LYR file for the ISAT symbology above can be located in your ISAT_Tutorial folder 
(ISAT_Symbology.lyr). 

 
6. Right-click ISAT_High in the table of contents and click Open Attribute Table to 

analyze the results of the analysis.  
 

The attribute table contains new columns for each analysis, two of which you are primarily 
interested in: AREA_IS and MEAN_IS. AREA_IS is the total impervious area within each analysis 
field. Note that this is in square meters, as the projection of the data and data frame properties 
are in meters. This value can be easily converted to acres or miles depending on needs by 
adding a field to the attribute table and using the field calculator. You can query the 
imperviousness of each polygon based on the coefficients for each land cover class by selecting 
and viewing the attributes. MEAN_IS is the percentage of impervious surface within each 
analysis field. This can also be queried for each individual polygon from the analysis theme.  
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7. Close the ISAT_High layer attribute table and Save your map project. 
 
You have now completed a basic ISAT analysis. Note that this analysis was performed using the 
High class of coefficients from your LC_ISvalues worksheet. The same process can be applied 
using the Medium or Low coefficients by changing the parameters in the ISAT tool Class of 
Coefficients to Use dropdown. The additional analyses can be useful for comparing scenarios 
based on population parameters and their corresponding imperviousness coefficients.  
 
Run a Basic ISAT Analysis using the Population Layer and Breakpoints Option 
The ISAT tool also has an additional Population Layer and Breakpoints option. This option 
highlights the reason behind developing different coefficients for ISAT. If one set of coefficients 
were used for every analysis they would likely be developed differently. This option allows the 
user to customize the ISAT analysis to their desired scenario. To utilize this function, a 
population theme layer containing population statistics is required. An example data set has 
been provided for this tutorial.   
 

1. Prepare your map display for another ISAT analysis. Turn off the ISAT_High analysis 
layer in the table of contents. Add the NJPopData layer from the ISAT_Tutorial.gdb 
geodatabase. This layer contains population density information for the study area. 
Right-click and open the attribute table to review the population density 
information.  

2. Run the ISAT tool. Double-click the ISAT with Change Scenarios script in the 
ArcToolbox sidebar.  

3. Populate the script interface with the following parameters.  
 

Input Raster: njccap06 
Statistical Zone Layer: NJ_HUC14 
Statistical Zone Field: HUC14 
Coefficient File: C:\ISAT_Tutorial\LC_ISvalues.csv 
Class of Coefficients to Use: Calc 
Output Layer: C:\ISAT_Tutorial.gdb\ISAT_Calc 
 

4. Expand the Population Layer and Breakpoints optional dropdown. This will activate 
the optional function in which the Population Field, Low Breakpoint, and High 
Breakpoint population parameters can be defined for a data set containing 
population information. Input the following parameters. 
 

Population Field: PopDensity 
Low Breakpoint: 5000 
High Breakpoint: 5500 
 

5. Click OK to run the ISAT tool. The ISAT_Calc layer will be added to your map. Right-
click ISAT_Calc in the table of contents and click Open Attribute Table to analyze the 
results of the analysis.  
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6. Examine the AREA_IS and MEAN_IS attributes to analyze the total and mean 

impervious area within each analysis field for the defined population parameters. 
Again, this is a customizable option for individual analysis and highly dependent on 
the population data and user input. Note that this example is in square meters, since 
the projection of the data and data frame properties are in meters. This value can be 
easily converted to acres or miles depending on needs by adding a field to the 
attribute table and using the field calculator.  

 
Apply a Change Scenario (Reclassification) using the ISAT Tool 
Now that you are familiar with the basic functionality of the ISAT with Change Scenarios script 
you can explore the more advanced functionality. The Apply Change Scenarios function is a 
great tool for analyzing imperviousness before and after land use change scenarios. Some 
additional data sets provided for you will be used in this section for the reclassification 
scenarios. These data may or may not be required depending on your use of ISAT. 
 

1. Add additional data used for ISAT change scenarios. Click Add Data and add the 
Golf_Course.shp and Development.shp layers from the ISAT_Tutorial.gdb 
geodatabase. These layers will be used as the land use reclassification scenarios. 

2. Turn off all layers except for Golf_Course, Development, and njccap06. Notice the 
shapes and locations of the proposed land use change scenarios. Toggle the layers 
on and off to note the C-CAP land cover classes beneath them.  

3. Run the ISAT tool. Double-click the ISAT with Change Scenarios script in ArcToolbox 
to open the interface.   

4. Populate the script with the following parameters.  
 

Input Raster: njccap06 
Statistical Zone Layer: NJ_HUC14 
Statistical Zone Field: HUC14 
Coefficient File: C:\ISAT_Tutorial\LC_ISvalues.csv 
Class of Coefficients to Use: High 
Output Layer: C:\ISAT _Tutorial\ISAT_HighReclass.shp 
 

5. Apply the change scenarios. Expand the Apply Change Scenarios option in the tool 
interface. Drag and expand the tool interface window to see the all of the options. 
Click the Class Field dropdown and select CLASS_NAME. 

6. In the Polygon Layer dropdown select Development from the choices.  
7. For the Reclassify as Class option select High Intensity Developed from the 

dropdown. 
8. Return to the Polygon Layer option this time selecting Golf_Course from the 

dropdown.  For the Reclassify as Class option select Developed Open Space from 
the dropdown.  
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Notice that both of the change scenarios are now listed in the Reclassifications area. The Apply 
Change Scenarios option has the ability to do one or many reclassifications and integrate them 
into the ISAT tool simultaneously. When using your own data this option may be very useful to 
you. Note that it is wise to have the change scenario shapefiles in the same projection as the 
rest of your map data. 
 

9. Leave the Fill NODATA Cells unchecked at its default. For more information on this 
function click the Show Help button at the bottom of the tool interface.  

10. Run the tool. Click OK to run the ISAT tool. This process may take a few seconds 
longer than the basic ISAT analysis. The ISAT_HighReclass layer will be added to your 
map. Make sure it is above the ISAT_High layer in your Table of Contents.  

11. Compare the outputs. Toggle the ISAT_HighReclass layer on and off to compare to 
the ISAT_High layer.  

 
NOTE: The ISAT run did not add a new reclassified C-CAP land cover layer into your map display. 
This layer is deleted as an intermediate step within the scripts. However, this layer could be 
useful for other analyses and for viewing the land cover changes within the land cover data set. 
To produce this dataset use the Reclass Land Cover by Polygon tool found within the ISAT 
Toolkit in ArcToolbox. This is a custom script that will generate a new land cover layer with the 
reclassification scenarios and class name symbology applied. 
 

12. Examine the statistics to determine change in imperviousness percentage. Turn on 
only the ISAT_High layer. Using the Select tool click the analysis theme polygon 
shown in the image below. 

 
13. Right-click the layer and open its attribute table. Find the selected polygon in the 

attribute table by scrolling or choose the Show Selected Records only option at the 
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bottom of the attribute table. Locate the MEAN_IS attribute column and note that 
the percentage of imperviousness for this area was calculated at 6.58% for the basic 
ISAT run without the change scenario. 

14. Close the attribute table for ISAT_High and clear all selected layers. Turn on the 
ISAT_HighReclass layer and use the Select tool to select the same analysis them 
polygon area as in the previous step.  

15. Right-click and open the attribute table. Find the selected polygon in the table again 
and locate the MEAN_IS statistic. The MEAN_IS percentage imperviousness for the 
same area is now 20.54%.  
 

Notice that the area designated for the Development change scenario changed three polygon 
percentages of imperviousness from 0-10% to 10-25%, which may be considered “degraded” in 
terms of imperviousness. This scenario shows that the Development change scenario could 
cause a 20% percent increase in imperviousness for the selected area.  The golf course change 
scenario resulted in the percent imperviousness of each impacted polygon approximately 
doubling, which can be seen by comparing the layers with the Identify tool or by looking at the 
Attribute Tables.  However, this increase in imperviousness did not appear to change the 
classification of imperviousness for its area likely due to the percent imperviousness still being 
less than 10 percent. The power of the ISAT tool lies in being able to do the land use cover 
change scenarios and compare areas that may be impacted by an increase in imperviousness.  
 

16. If time permits, perform the same statistics analysis for the proposed Golf_Course 
change scenario and calculate the increase or decrease of imperviousness based on 
the MEAN_IS values.   
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Appendix 
 
Contact Information and Technical Assistance: 
 
NOAA Coastal Services Center 
Dave Eslinger, Ph.D. 
(843) 740-1270 
Dave.Eslinger@noaa.gov 
 
Matt Pendleton 
(843) 740-1196 
Matt.Pendleton@noaa.gov 
 
Shan Burkhalter 
(843) 740-1275 
Shan.Burkhalter@noaa.gov  
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